23

STA 6000 Z&& X
FdEES

HeR /RIS (L) FRAR



STA 6000 157 H] T JJI—PerkinElmer




STA 6000 157 H] T JJI—PerkinElmer

H %

H—Z STA 6000 X S& 24y 1
5”& Pyris Software {75 7% 2
=3 STA 6000 {YEE4#ZIE 17

FUE HEESH 22




STA 6000 157 H] T JJI—PerkinElmer




STA 6000 1 1 F- it —PerkinElmer

& —2= STA 6000 1L S& /7Y

5% [ PerkinElmer 23 7] 2 5 b dge BT A A B A Il v, 2 1R B st
BRI . FL STA 6000 [F]25 B oA A8 ) LA IR 4 1K) TGA. DTA/DSC
55, AT RADR A RE S AU TERE . 22U 7 BT BB AR L . H5 K
gidithae. BACTERE. MR L R RS 154 e A I RS IEfE
WG TR TR AL T TN RS A AN QU ) e W A AT 4 ). STA
6000 HATILF M PERESRbs, Bilt:

® LEYEE: 15 °C~1000 °C, WA i FEAR, T AT A A A b b K 4 A
eSilE

DT #1 DSC (mW) {5 54T o, M uiEiis g A g

KPR 0.1 ug:

EHRGSL: £ 2%;

FHEEZ: 0.01~100 °C min-';

AHITEAE, AER IR R, M 1000 °C B E] 30 °C /T 20 434

B R BTER EAEA, T DU R R R BT D), O T3l
Gl sl A sl

o HULE AT LIS Bl (MS) B4y 7ot R) BTN .




STA 6000 1 1 F- it —PerkinElmer

5E_ & Pyris Software £ F /5%

2.1 ERAHEIR

F AT LA Windows 2000 5% XP #1522 4t i I 4k S b R Pyris 300k A2
B R I R “Pyris BAOFEFERE”  (Pyris Manager) HUE T IT A B bk R 45
S b BRI THA&, AERBCT R4 RATIIRE R AT 2 U E D
FH P aT AR 1) B (i e oSO e AT T A e T L@ S U AR B 1 T 4 A B AR N )
VRSN T, ARG AT 1 A R A S R (A . L e s s AR AT AR T
BoRE DAL R EE AT BAERGTFASE AT Pyris BAF OISR
ZiRCe

Pyris SR £ £ (Pyris Advanced Software )

M@ Pyris Advanced Software b ] tnstall Advanced Software
df] Pyris Help 3 E Install Enhanced Security
IF) Pyris User Manuals 3

% Pytis Configuration
@ Pyris Data Analysis
Pyris Manager
|E§E) Pyris Readte

F P v I i TR B (1) e B 3 (Install Advanced Software) , il 1P
G (MTDSC) 8k Pyris 8l J1 243k, LLRZ%E Pyris #8587 22 22144 Clnstall
Enhanced Security) -

Pyris #7873 14 (Pyris Help )

I Pyris Advanced Software »

B Pyris Help %) Pyris MultiMedia Presentations
Ll‘j Pryris User Manuals 3 @ Pryris Software Help

% Pyris Configuration
@ Pryris Data Analysis
Pyris Manager
@ Pryris ReadMe

IR Er LT WinHelp 192 GEAAE 7R %0kl (Pyris MultiMedia Presentations) DL &
H W SCRY (Pyris Software Help) o 2 @AY 7= WOk AT X $5 5 H 7 ol R B



STA 6000 1 1 F- it —PerkinElmer

Uif) 22 TGA ffy 225555 . TSR NI T PerkinElmer 23 W) BT A7 #A 73 Ar A 25 (K4
JHBEH, BT AT AR A AE iy A jlidi 7 <555

Pyris 2/ P & /FF A (Pyris User Manuals )

Pytis Advanced Software -

Pyris Help 3
@ Pyris User Manuals v | & Pyris Installation Manuals 3 Z Ethernet Communications For DSC §000 and DSC 8500
% Pyris Configuration Z Pytis Enhanced Security Manual Z Installation Meeded Eefore Installing Pyris
@ Pyris Data Analysis Z Pryris Kinetics Manual Z Pyris Advanced Software Installation
Pyris Manager Pyris StepScan Manual Z Pyris Enhanced Security Installation
|5§E) Pyris ReadMe Z Pyris Installation Summary
o Z Upgrading Pyris

ZIEIR S T Pyris BAFARALIF LI PDF SRS, B0zl )y 22 81 AF e v

(Pyris Kinetics Manual) 4545,

Pyris 2 4#£H. & (Pyris Configuration )

Bl FPRIS Software Pyris Advanced Software  #
Pytis Help 3
Pryris User Manuals 4

— Puris Configuration

@ Puyris Daka Anakysis
Pwris Manager
@ Pyris ReadMe

FH PR CUE ] Pyris 3440 B BT HEAT STA 6000 {X 28 B B . %k I0 B r) LA
M Pyris #4457 FL 4% A (1) Start Pyris A, Al LRSI 4 s i

##E##7 (Data Analysis )

M@ FPYRIS Software Pryris Advanced Software  »
Pyris Help »
Pryris User Manuals 3

% Pyris Configuration

e Pyris Data Analysis
Pyris Manager
|'_£_g] Pytis Readve




STA 6000 1 1 F- it —PerkinElmer

Pyris 00, 5 2o 20 A 20 A v )T Ak BE R A SOR A B Bt o 180l 70 B ik
PEEATIE AL, A8 Pyris BXIFIERLIN PerkinElmer FA 7 H A a8 34 w] A FH i 40 A
AEFREHE . BeAh, P AT TR I A EE 22 A

Pyris 2t EEE#E (Pyris Manager )

B PYRIS Softwars 3 Uﬂ Pyris Adwanced Software  k
Uﬂ Pyris Help 3
@ Pyris User Manuals »

% Pyris Canfiguration
@ Pryris Daka Analysis

= .
28 pyris Manager

|'_f—-Q Pyris Readie

P ArERL Pyris S BRI A S ZEHIS 0, At el [N SR 5 &
HUAGE BT 5. AN, B F2SE I PR IR : Bl o driiar, Wisiss
BATRG, ECE STA6000 =4, Pyris 15 Bl SCHY LA S 5¢ AL T .

Pyris B3 1% (Pyris ReadMe )

FRSCAFHIR T Pyris JAFRRCAS I BB 8, AR RRAS 1) BB s 1k LUK 35 Bl
SCRSH RS B AR A B A AR A SR o

2.2 KT “Pyris Manager”

PE /A BT )l A “Pyris A5 FE %87 (Pyris Manager) HATHRYS,
Pl A “Pyris Manager” i FHIZ AT 2% LA/ B B0 55 N R T o Tl I A A T
IR AL A BTS2 00 ) W LA AS IR IS BR 5 WU IE R 2 53 Br

5. H4h, Pk AP PSS IN R AR B A BT AR BB AT RS
Start Pyri JS' ot sngg 775 °C sl Toafﬁ?ne 3| e Ts%??sz .
AtTemp | & |------- Heating
Pyris Manager & 7R 52



STA 6000 1 1 F- it —PerkinElmer

F4h, M PAE “Pyris Manager” 7% 1 X L A BN, Bk R B R SR
PRI, WX “Pyris Manager” W I TERAE, HAKN W Bk

Always on top
v Autohide

Cascade
Tile Horizentally
Tile Yertically

Minimize #11
Maximize A1l
Eestore All

PerkinFlmer Home Fage
About Fyris. ..
Exit

o TR¥FHTNGZE N (Always on top) o A IBITZALE N, ZEIREB LR “Pyris
Manager” #5441 T 2AT 55 % LK B Y QR AT RN B £ T 2 3 Bai
hfe, B3k,

o [ZhKEHK (Autohide) o M P IOEHARME I (B word Z8FE)F) ,  “Pyris
Manager” Kt A gl Bl AR A A)1E “ HARa” , AR “ PR A 2
R7OBR LN BRI RS, “Pyris Manager” KF HBh e ], Kk, A SRR AR
“ORFFHT S BN 7 IR AL TIEBUIRE .

o TZWI/REH (Cascade) o ZILIUAT UL Pyris A1 i & H LLE 2 7 LR .

o KA RE I (Title Horizontally) o %330 ] LIE Pyris %14 A (1) % 11 LLKF
Ay AR

o EETHIE/RE O (Title Vertically) o Zi&I00na] LUE Pyris &4 i) 7 191 DA IR B
i s

o I/MEPTAE H (Minimize Al

o AMPTAHE I (Maximize Al

e PerkinElmer =11 (PerkinElmer Home Page) . midiiZikIi, nl#E A PerkinElmer 1=

e

~

o KT Pyris #% A (About Pyris...) o H /7 al il st i3k A A A RAE B .
o JEH (Exit)



STA 6000 1 1 F- it —PerkinElmer

2.21 XF “Start Pyris”

“Pyris Manager” Ftifif & —A> “Ja ) Pyris” (Start Pyris) %4l |Stat Pyris
FAH A IR LIS 4L, A v — G v SEHLRIN 2 & PE (A BT X
%, MEUESEINAT B CRBHUS BhigsL . P I sty “Start Pyris” 4441 R 2R
RS R, AR

Data Analysis

Configure Analyzer

55 S AL o I T

o KA HTEAE (Data Analysis) . FH /it fidhi “Data Analysis™ it ANk 43 #
fF, ATHEAT IR

o W&V (Configure Analyzer) . H il iy “Configure Analyzer” i AAXASHC
BT, B INSAHBRICHL STA 6000 ok # LA M se. s iniss
FCE e, AH NS 1 5 B34 Wos e “Pyris Manager” FifiH

o P (User Management) o WIS HH 7 2 1 1lom Y 22 2 A4417) Pyris #044,

W AR A A PR, BT A, HiESHNRE . 7

Ab, AZRERPe BB OGRS M RS A oy s AR R, AT AR
.

o il (Help)

o XHIPA (Close AlD

222 XTURIEHIER



STA 6000 1 1 F- it —PerkinElmer

Pyris A ARV — S THEHLFIR IR EI 2 & PE BSOS ES, B E sy
BT CAE “Pyris Manager” S A #5A H S BHLE b 4L, Bl Lk “Pyris Manager
WoRFt” B AL DSC 8000 Jib a4 4l LA A Pyris 1 TGA Ji Bl #4155

DSC 8000 @  Pyis1TGA @
o (57775 °C @ Dffline
&
BHRTS BRAIRZS

03 A S L)/ RS U S AN AR, 20 AR AN IR 35 3. i 52
SO HEPITRRE, BAOERAE TITHURAS, /DM R I e Bon, AW B
HW, AU T2 AT SEE RSN, 2L KR THR MBS (Heating) & (4 387
Bt (Cooling) , #ift & /n#R F4 (Equilibrating) A% (Holding) IR&. fiE
ICERAE T RHUIRAS . TS8R AT LR S8 i = Ft ik, {2 3 3l fm 2x Bkl “STA
6000 NAEMATURIL” R7-HES

(SR B EA S A SR HE Cn D o BRFUIRES R w] SR i R
(Sample Temperature) 545 B AVRA TR R “Offine” o P Al R4 75 2204
A W R SIS e TR s KO s 2o N T, R AR AR, Rl
AR “BIRAE R (Change Status Information) HGHE, #milid Ny HEE £
AMER GER: AFRAGHAEPER B E B & AMED o STA 6000 A] k£ Bor
fF AL HE . “At Temperature ” . “ At Load Temperature” . “Go To Load ” .
“Calibrating” + “Equilibrating” . “Holding” . “Heating” L\ “Cooling”

FEHUBR: 8 53T T s SR 47T STA 6000 Hadii, JEAS A/ <Ak ]
AbF SRS FTIF “Pyris Manager” Jf- st “STA 6000”7 BAHLIZEL, 2548 K41 10
FREN ] Pyris =457 A 24T IT

BN N T B BT =H TR B MR SRR bR L
B R B AT RIS H LT ARASE: (Status Panel) , A7 34 2 21
[fi#i (Control pane) o HI /= w] LU H QL5 4F 1T il TR MALE S on e 5



STA 6000 1 1 F- it —PerkinElmer

Gb, THPEREHEAFPRES T CafCss MRS FEGE RS Sk AR
LIRS LR

o Instrument Viewer: ¥ M5 (HI LEMRZS) » il 5 sl

e Method Editor: J5iddt, sl |B I

o Data Analysis: H#i 57, fiihi | HRHEIDI%

o Pyris Player: Pyris #fji#%, miii ‘o HEHIDIH®

ANER BT = ARES NSRBI (R3O o EE 4PIRA IR
AR, SR J5 A 4105 g e A I %

2.2.3 IRSEHR (Status Panel)

RAMH (Status PaneD) H1 2 AN Wos THELLRE, RS HESS 435 S 501 44 PR A
HHE. H A R TR AR BRI 2. MEORBHOREZ G, 2SN AT
(H S BoRTETTHE . Ak, FH Pt ) DU I iy N 250 - BESOE R £ B oR S 4L
B, T LUE R IESEAN “f” P kA (Furnace Cover) . 47l (Furnace Temp)
SELL “E7 ARSI S EU AT Uk

WSHASAT A S EERHE, BN R DS A BontE, H R
IR SARGS A AR AR B PR AR A 2 SO a1, AR5
i IR T LS, BB S8 0 st js D s HE R B . REA TR 0 A4 A 2%
F P af DO el 1 B L, R o A N, B s AT PR 20 B 52

2.24 #=#HIEHR (Control Panel)

S TR (S O AR TSN, SIS T
WUE CHUIRE, Jivksidft, Mk . TREGESRE) T LU % il 2
SRR, JE SRR S (R e ek e g
WL (Stop) 5 21 (B 4 T e AT . ek bR 8 e, SR
SR HE I BRAT, I B B I B B . 58, et L
WALE B Dife. W R P AR RS A 1 FL U o¢ DR R Sl “Pyris Manager”



STA 6000 1 1 F- it —PerkinElmer

STA 6000 JA hi%tll, BRBAFCLR5), EATREKENUIRE, “Start/Stop” #24L%

T T | g, RO T T, T L T L,
O ML S AT, 45 TR T3 B 2 5 0. VR DR
BABHGSTIA, BSOS EU A AT “TRIAE R TR,

1
“YBEA%4”  (Go to Temperature) o JH /il ik fid &8 F iz 4 H R
D7 B BEGRAEAE, ] DA S I BA TR 2 R, SRR ] UAE “Imif i
(Preference) i (¥ “Go to Temp Rate” b4 7% 5E .

£
M “IRIBINFERE " (Go to Load) o KRR U BE Y RIINAFRIGE o DAL
(Load Temperature) 7] LL7r: “Preference” % €

H “CEVRPER” (Hold Temperature) o ANiBAXZS AL T 25 NIRRT &R P42
WP B, 4 P A A A S S B T AR 2SR B R AT SRR AR R

@' “CIEEURE S ER (Sample Weight) o 1% 50 AE SEE T UE 5 48 R TEROIRAS
R P g o i g DAz ORE 285 R AR it o [ IR £ B 33 N 1
BRI =N

1 > =5 ” H AT 34 > 75 N
E‘ CEHE L7 (Zero Weight) o ARSI TT 4R J5 A8 I B RCIRES,
T S ZE O AR L E R A FE R . .

@ “HZhHERE SR (Autosampler Control) o WIS B RE T H SRR,
A S IHERE N B S BERE S IR (N ED o PR )
PR A SRS BRI LR R, ) DLHEAT B Sk 3 0 1AL I LA R M A2 R A
fHERAE . RAARRIE 2 L Pyris Help H >k .

UERACEARRC A ShHEFERS, MR LA T R BCIRES -



STA 6000 1 1 F- it —PerkinElmer

Autosampler, Control E|

Sample Commands

Select Carousel Location:

1 Load Sample
Unload Sample

g | RESET| T

ﬂ “HEEHIRIALE T (Reset Monitor Button) o %4 1 - b B i 42
T LI B SE I th 2. T REAT o AR T ARSEI I, Hicdhs AR
SN IR IR G 5, SR TR e, B AL S 1 3T B JT I 46 I At
S ES

Change Purge Gas

Mitrogen -

200 ol min

0 | om0,
R T E A O TR . O R i A “Apply” AL (R
G . LA R 1 o A SRR B Rk O3 T s

225 FiEtwiE=E (Method Editor)

“SEBGTTVE” RFRRIE S T AR R TR AR AR S B AT B R AR, TV
3% (Method Editor) il S 7 vA I T H . Pyris SR04 A TBEAT BRI IR 5 15
- CERIAIAE TR 424 C:\Program Files\Pyris\Methods) . JHI /™ A] LAYEBRIA 7 vk b kAT
SHIES, WE S FTIIER I NE SO P i AL N i g e . | B
TE GRS, P o] LGB (0 5 50 tF, T AT TP — N R AR R T ik
SO TR S AT USRI R, e B K FE R AR S BCE DU (Sample
Info) , WIGPIRA W ETUH CInitial State) , F&/P#sE s & T (Program) LK R
T G (View Program) .

1. #mEZTE (Sample Info)
FESE B oty a8 R TR E, LR AHRE. I TET
M B HEAR, AT BUS & 5ETA S RSN .

10



STA 6000 1 1 F- it —PerkinElmer

LIEBRREE
o FEMAF (Sample ID) : KA 512 NFRF, W TXFEMBEATAR R (]

%)

el 45 (Operator D)« S KT 512 ANF4F, FIF 04k BT hroR
(AT

PEA (Comment) : K AHIA 512 ANFAE, T S2H H AR b 7 6 % ik
ITHER (Al

HREEREE

HEE R (Zero) « ZEIUYFE AL E B (ZHE) , Rx(ElE h EE % 5
B Al DGR e R R R R SRR AL, s
HA R RE A RAES R0 o e B AT RCE AN E R N
AR (Weight) = I ALL mg 2y 547 (ORE S5, ERIAY 1.000 mg. JH AT
LI e A7 P R A A BREORE bl FE A 4 B SRR AR T AN B
HEr CRIATID

R AR EE

SCAF4 (File Name) = FH T4 NARAEEUI 1) ST 44 o Pyris BT BRIAIK SO 44
QSAVExxD, FHF'AIDALE “Amly e & o 17 o oo BoR BRI 4 . ERN
SR W RS S S s i SR SRS, R %
S SR WY H SIS S 4, BIN<IEE A, H B <75 X1
F001, <FEE I NFE>002+++, EITIEAEAL ] A SRR AR AT W R
VP 536 5 AR 3 X 1 SO0 44 TR I AN 5038 SCpk 4 i, BB 7 75 1
)5 - @YYMMDDHHMMSS.xxD LA 3 Js A S04, e YY J4E4y, MM 2 H 4
DD N HA, HH A/NEF, MM Jysrsf, SS Fbel, xxD H T xx A FFAE TR,
D f{5& data.

W (Browse) = R P AT A SCRBHE RAFALE, AT LI Rl i AT T
GRS T HE ;

#4% (Directory) = 1ZiEI0 SRV P o828 B0 R PR A7 B A5

11



STA 6000 1 1 F- it —PerkinElmer

2. #3aRZSTUE (Initial State)
PP AT ARG RS DI rh B B A K A2 17 STA 6000 XA s AE A=A il

W BCE AV NI G 5 B s HIWTRAIES 5 R B, 2 il St T Y]
BAESE . Br) i, 20U EEE R TR ST A SR R, AR
FE5E T I8 5E 25 A 800 2 AT A 5 4 BETT Rl R AR /e . 534k, i UiiniE
FVFH P BOE B I IR AL AR (1 DA S R 10 5 BB B e . AL T HBR SR ER T e,
“Brown” FHIKE H BN, ] 7 SRR I BT BR AL I 44 B A S AP AL B . 1%
D RE SCVFAX IR AEISAT SER R b E B0 R I i PR 2 Bt . U S ke 52l
(WAL BRI AT LR ANBR S8 . 24 78 “Pre-Run Actions” 5[ #2011 X 3 i ok
BUbRAT BN, Bkt RIS “3ishE”  (Pre-Run Action) i&THPRAESE L. T fi
K o F L IRFEA T8 — B«

fdd an A;tion

#dd an Ewent

Edit an Ttem

Delete an Ttem
Change an Ttem

Expand All Ttems
Collapse 411 Ttems

o NI—ENME (Add an Action) = BBk H PIANIE DAL Pk gE. “CIsAT SRR
(Start Run) Fi1 “4N#<44”  (Switch Gases) . WIS k4 “Start Run” , N
HEN R T )6 1 AE -

H¥hat Event will cause the & ?%’;'~ 2ﬂ'
1
Current Action: Start the Run

¢ Select an Event that will cause the above

A Signal Equilibrates
A Specified Time is reached
‘Action occurs Immediately

[ ok | Cancel |

FIP AT AAEAZ6 T HE 2 A I AT S 0 (1 S e 4 1F -

12



STA 6000 1 1 F- it —PerkinElmer

-> “A Signal Equilibrates” RS S5 A TEAME 5 A B4, IERE S
T (1) AR 0T T HE «

Current Action: Start the Run

: Select the Equilibration Event
that will cause the above action to take place:

Criterionfm—- s
[~ Use a Setpoi 275.00 ° C
(¢ Start at beginning o

(" Start at timlU.UUU min

| 0K I Cancel I

FH PRI AE R P AHE A i 6 LLRE LIRS (Sample Temperature) 5% DURE 738 (i
(Program Temperature) £k #5155 . 7E Criterion iy A\ A i b v 1) 1 A7 s 2208 o
WIRIEFE T “Use a Setpoint” I, QKA XML T REAT IE 0700w 22 19 R W o 45 00,
FERPER A LLSEIG TR IN AR A W AT A0, wT BLASK TR, AT UM TT 4R — Bt ]
JEAE R IEAT I M

> “A Specified Time is Reached” #& s i JT 45 J IR I [HI/E A 38 AT S50 (R et 44
- “Action Occurs Immediately” WA rithi FFaa 5 S RIIEAT LIS, WA AR e vtk

WRAER INBIEIE DU 7P T “Switch Gases” , XAy K LA AR DI AE R 18 4T
S E AT . LR AR AR R SRR (IR, R BT

Gas Switch Action ]

Select the Gas Switching Action to occur

Change the zas to:

Set the Gas Flow IZU.D mlfmin
[ o | Cancel |

13



STA 6000 1 1 F- it —PerkinElmer

IEUA I E G TR S v e <0 N S = R AN = R AN e AN 7 e AN S AN 2 A 1 B
B A 1EFE OK i Al RE 2 i H A A 0 W AE, 3 5 UM e 45 A
W — A AF (Add an Event) = A fiik £ (1) U7 % W FE A 5 “ A Signal
Equilibrates” ;  “A Specified Time is reached” ;  “Action occurs Immediately” =i
o i H (Editanltem) : msidiARESH, R0 1% HEATE S
o R4 H (Deletean ltem) : JHIR& 4Tk 4 H .
o K44 H (Changeanltem) : 28 4niikh4cH.
o JEIFIIHSH (Expand Al ltems) : HFREIFFTASKH, Wn] LI BARSLIH
IrRETT o
o ST 4H (Colapse Allltems) = FT&4fra4H.

3. #EFigEmmE (Program)

% UUTH ) N 2 BE v e B T v B8 (Method Steps ) AN R 1 B 5 A8 4k o 7E
“Method Steps” #lKH, EI/RRZMEERET. WM AE “Initial State” % A HE
SOV, F P o] DAZEZ TR B e Ao 3 —HE D SEIUN R AR e e 2, A
TP (Adda Step) « AL HE (Inserta Step) « MMER4 H (Delete ltem) . 1
InzhfE (Add Action)  HEhngiff (Add Event) FI45H 4+ (End Condition) o -4
—NPER, W RE NS N A SRR BARS S xR AP IR, I T AE
“Detail” Hoxf A BRI EAR A 2R R H 085 HEAT B RLAA

F P AT LAFE “Data Sampling Options” 36 70 P g A8 A AN 5 R (K B S 35 . AT L.
B 52 B0 2 AR “ Number of Points ™ 5 R m) DU s 4 0 SR 4E 4 “ Seconds
between Points” o ERIATG L T, JNiEsIRPANAE — AR, AR TE Y 1 min.
%~ “AddaStep” #Hl, HHIXIEHE, BAKN AW T ETR:
> “Temperature Scan” = it BE 4T, AT LAHEAT THEMIBEUR F08  (¥E WG TRLE
TSR VA THEE R, Sz AR ) o 45 Uil BENFI Rl A0 /2 T A
Mgt BB S, WP GRECA SO 22 R D -

14



STA 6000 1 1 F- it —PerkinElmer

Fdit Step 2)

From: 50.00 ° C
Te: a0, 00 3
Bate: [40. 00 J

Hrp ) “From” WL FER —20 i g aii FE s i o sg UIRWIUGIRE A . “To”
FoRHFZ . “Rate” B2HMHER. WR “To” WIRELL “From” IR &,
AT THR I, 5 N T BRI

> “Isothermal” : ZEIRVRJEREE, SRR AT LME S, W R RN

Edit Step 1]

For: Il.D min

ht: 50,00 ° C

> “Repeat Steps” : BHE D, nfLUEF—DER, W] DLUER ) UAIELL NP BIE
HEERIC.

1% F “Inserta Step” #%/41l, #AHADFHENIZ T “Add a Step” #&H HIAHEHESE
SR DS R R TE BRI R 4 AT A0, T 2 e I 2

“Delete Item” =] F T Ml 24 A 2 WEAEOUT, W SRR T D R S OREK,
MR 23 P RGeS 20 38 . X B “ltem” T ANH “Step” ¥ 5 A 2 4 |y
Kb IR v G5 s E (Action) FIZE44 (Event)

R “Add Action” 2, £45 TR =ANIET

15



STA 6000 1 1 F- it —PerkinElmer

it
Current Step: 1) Hold for 1.0 min at 50.00° C

Next Program Step

0K I Cancel |

“Switch Gases” : VJHt 4k, fidi OK < ISR TEHE, P a] DLk
PR R, RIS XTIEHE, $EonH e SR s 18 & 2B &

- A Signal Equilibrates: 15 5 P47 135, [FIHT;

- A Signal Crosses a Boundary: 155 i 31k S 444 il s
- A Specified Time is Reached: . H: 8 2K I 1] Ji5 V)45 A4
- Action Occurs Immediately: 7. EIE4 7 440 4t

“Stop Run” : R IEHd R . WG o IR AE, 3o F T i o B R A
kAT, [F L 4 4%

“Next Program Step” : #EN T —MEF DK,

“Add Event” SENINFAERIAT S . 102 “Add Action” SEA NG Bah¥E, Ak
Fal ek

“End Condition” : {X#&5 W AN 1B ARVFFH - e A SE I 45 5 1 |
eATENE. B, P AT DL RS 45 S [ 2 INFEREE (Go To Load Temp)
AT DAREPEAE S0 25 RS S5 (Hold) B M1 31 Fi e (MR E{H (Go To) 4555, 1Bk
Je AT “Done” A REA N AR AR
4. FZFMLITIE (View Program)

F P o] DAAE G T A6 B IR R e . DRSS T R A, W ARZ AL, ST
IR TR

16



STA 6000 1 1 F- it —PerkinElmer

®=% STA6000 {LSEHIE

JUT B RO AT AR, A AT ARSI E,  STA 6000 thAMI Sk, LA FEAL
141, STA 6000 S8 2 B R AR A, RIS THE KISh&SAT NAT, e T
(KA1 525 ) AR 25 2R 2 R S T R BB . 5340, bR AXAS 45 A R B,
TR TC PR AN TR B, BRES [R]—AR (Bl il S RS
SR AN A IE TR IR I A AR R AR i 5 A (R ST S 5 . A
IE R AR e R A T AN AR HEDI I (RO ARAE) , BB A S 2 fh
g, AR R AR A, A SN A RN, MBS 1S, anR
A2z aisli o ol Al RN 2E e 4 8, TR L AR B 2 e W] Wl o 3 S
HE.

STA 6000 @ $R BEPIFIAL I 7% —F CD N RARIE CGEEer iEminT
DL AL CD Jeft S ASEIMALIED , 7 — M2 FBhRIE (Manually Calibration)
STA 6000 YA IETUELHE: HEIE . ARKEELIE . DTA B2t i BRI BL &
AL IE. HPRH CD it S AR IE T ] Ak AL B A 1 i AR 1E DA K
PR IE, (HERFHEELINF P TRIE. b, HPsiTEERIER, B4
NN B« MR B PRI IE T S . FARD 3R R ik«

CD ABESARKETE
CBBEAL B AR IE A H IR IE S EE D& Pyris > Calibration folder SCA32 T
Sl CEAA ) Calibrate > Calibrate Instrument 328 500HE N A 2845 1E 41T, Bk HH 056
AR W7 108 241 A AR s
3. Adi T EAAd [ File > Open > select CD calibration file > Open i 5014 4 UL 42 1F S0 A4
SFNEMES I IE AT IEHE . SRS B “HiN T N7 IIXHEHE, THIEPE OK/Yes 7
ANZIEZHL
4. fEHIRENLACHT ) 100 mg ARt B S AR B E R PATIC R, BAC R E R E
TAGET, A EERIEEH, TR R HE S A E R, A2 iR
JURAF B B IE S

N -
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STA 6000 1 1 F- it —PerkinElmer

5. MPrARIE MR, HJ ] i Finish 4% HLRAFAZIESCAT

A ST P ANAEAL T BEATL B 5 i B ARG AR IR0, 5 2 2Rl B SRR B I3
W EESEASEMENEAT EE (B &P Indium BIET > A Edit 3441 > =
B > midy OK IR, X Silver LA A MR TIUEK FIAR R D BREATEED . 1M
J o ST O ) S A o N B AE N T 58 AR IE o 7T R R P i
Accept Values $Z4l1 K ARAF k5 20 2%

o FHRESRE

1. M THEAF Y Calibrate > Calibrate Instrument, T TR IE T . 4014 IESHUE
7R A ERINE, W E R o Start Calibration AT IEAZBR: A IESHON BRI,
W ZEERIESH, AAEMEEA PR 3 Default SCIFE i Restore All #4 ;

2. SENEEJE, sidh Next 4%4l, EILHEANEERIEIUR . Kebruh &S T,
siifi Run Calibration #2411, MRHEEERSHERATEH B IE, 5E8UG RAEH mlili Next 3%
BHHE AL AR A 1 I

3. ALK IETUI Y, BE W AEE I 30 °C %2 1000 °C, i Run Calibration 447
Sensor Calibration, #ANEFEKAITH 1 hr, S2RJRHAFIFHEN T —MIER L

4. HIAE DTA B A 1 b R B ER I, B 3% itk Run Calibration $447 A 3h£Z
IE, seJa s Next #2481, Bl BEAR IE LU AR IE DU (4248 fiidr Next)
LU L Finish 28, i AR AT R SO, BT ) 344
WE N “Weight and Sensor Calibration + H 31”7 #:0. SSHIRIE % 11,

5. AEJ7VE S VO THERR Y, SR HTAH [R] PR T2 238 23 7 0 i A A A AR AR A 11
JHiG DSC Mgk, FRAFHE A LA RSN . HRse s, Ml gl T
HA% Cale "N HIHE R BN B IUHEAT 5 il A SR B oA, sl S A

6. FTIMRIER M, [AI sl Start Calibration 241 ;

7. gl Next H208] H 2)HE AR BERS I DU, ™ AT AR 12 0T s in e i B s
FERIE . 2B Indium FRkE, SRJG RGEAL AR Edit $28,  H 2R S Sl
DA ST HI s 2 A5 B A BN &, midds OKe [RIFERILE Silver FRFEH A
FHNSEIME, iy OK CHRITIH AL A Indium,  #57] LLZS IS8 S bR FEREA T
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STA 6000 1 1 F- it —PerkinElmer

RRIE) o SERUGE %6 siihi Accept Values $ZHH BB S IE S 4L, AR 47 I #4
M IEAS PR, 3 A OK,

8. st Next BEAFGREZIETUM, RAPER 7 (75 B0 AR R RS B 2 E 55 280
AN ZIAHN B 9 3 55w Accept Values #%41L EBT S 1IE S 40, 5e i mids Next 3EX
R IE S L s

9. FESTAR I, MW RGN AR PR S R BA RS HUE, #IN R n s
Finish #281 I ORA7 R BT AL IESCAF . BQIESERE, RHIIE S H .

PS: 1 AE#Haum/EIIE? HITELIEZ/BIIER] Onset im ZTEXKIE S ?

I AL ISR DSC HAm M £k (ki CRIVRLE R D BEATALIE, R ff s 5k
DR S5 T ARG I B SR . AR AL IR, AR 4G R (Onset) &Ml
B, T8 FIREROEEBOZ S A IE H xR AR AR A A R 2
el E MR EEVE . DORRIIE 01, MOTins i B ai e i, — s L
FETh A U RR B, M A SIS AP e . IR, AL
SRR LN B, TR RE I, AN G Rl A e T
(o H A VR i Al AN AR R (W R A 2E, i 3 . i AN 45
it J5E 2 FiR W AT S PR AR AL R B R — A D2 5 B2 A AT O I R 5, KRS
WrAESE, R R R MR o RE TR IR S, W R R ARG
(B TN AR B, IEIRAEAE AN o T 4 FP gl 1 0 A0/ R R T Ut
2 X R A, EAMER At SR AT R 1Y, IRt At A B MR iR

Witk
4 3
= =
= ES
WEET WEET
P3 Rl R r B4 Wil L5 AN AR B 1 bL AR
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STA 6000 1 1 F- it —PerkinElmer

T REAT R E FARA 5L A

T A E AR R R AR AR EOA R RS T RIESCAE N default) 4%
— BT (B EEEERARUEYR, T Onset MLEMFALS AH (I AH H
TG VAR RSN REMBHME R ED N, TS
SVEREAT VS LU, s RS 1 TR A o ) A A U o 0 TR R E, ARE
PR IF A SR e H P 250 Y R B 2 s IE, A S eVt SR RS I o TR
TR E R BEVE 584t T P AR B i R S AR A R e . — OA RS IE
(RO VO BB, W BN B R AR ] PR 25 AR I AN KPR B 3 2
ANGER, hit, PEARESE T 2 MbsueY) SUEEH ik $E . W N &R,

PE #E47 % ] 18O 9000 Jit f: A& R IAUE I FRIHES L) (Certified Reference Materials,
CRMD BEATAZIE . wt H AT SCHRK T, — MR T M il BE RS IEVE R B R 1 il B2 3G
LV 70X A L BE VS B DAY o 90 PE 24 m]4fE#E STA 6000 5 I il FEE A% 1 16 FH P v
Aba AR Cndium) FIER (Silver) 43 J ) FH L Js il 58 A Jo R EA T AR OE

RS R
PREESRIY FRFEA TR W | AR °C A gE J gt
il Fes 156.60 28.45
7 Fes il 231.88 60.46
bR A By yaati 327.47 23.01
Br Fe il 419.47 108.37
i Fes 961.93 104.76

XTI 7 ZEAIE STA 6000, PE #EFZAIMGEAL: TTHARSERnr, HIARHEY) Tk
Br—1, MRV NARE, CRATIE . KW ATE UL SR A DR —. BR
BELLSR, A7 RO OLL B, i AR E -

v BRI AR . — R FORT I T A IE AR TR o ST B R R
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STA 6000 1 1 F- it —PerkinElmer

S(en S
v SRS EURIR R SO . STA 6000 WIS A HE R AR Ak A o URR, A4k
TR R M A S w2 A1 DSC M2 B BN sl . 1L, 2R AR AR
BAZEMRK (s S RARIOE K TR .
v RINTERITHL CRHELE) .
FCIER o e O St T FEE R P e B PR PS8 DX T AT TR 4, T I
S5 5. AR R N I R R, A R T B AR
WY, NBEEVE. A, R R ELE N ROR .
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STA 6000 1 1 F- it —PerkinElmer

BUE BT

e o BT AT SEIG I E A . R HEEAE, T DAMAS IR ) AR AT A
BT, BREIAFRMEES. g R E R TR0, 152500 H P AR T DL A =
PEE . ARFDR B o M i Shae S E TR, WIZH 5%, F 8
BT T Pyris B2 — Gl A, Hoh A e ohpe A 2 STA 6000 i1, i
FHF HAbB B2 CEbtn TGA 58 DSC%%) , AEEAZE KL 241,

T Pyris 81 RH T 2 LFEEAR, KNk, EUHA7T B RAE K [F) i ik v] DL T
SEIGEPR AL 0T, P TAERCR . 28k, F P HaT IAEBEML A4 A B
AR LU E BN LA I . BT Pyris BB AT B AT 00407), R pL
s o3 1 b ZAE BRHL L I AT

G E 8 “Pyris Manager” , 2 Ja S {E B4 b7 B Pyris AT454% (RTLA%CH H
kD o i “Start Pyris” #5401, KZy 10 kS B ATHE B b S, [H
T AT TR dp e — AN s S
41 T Ef=
BRI VPIRE T, AR T a0 W HE T = A

(k9] D=eE| SR X% wi#E x|
2 o B 7 o s [P T

N I LT REREAT B -

S e s Cnstrument View) o 5240 B F1AE b B4 B AT 11, P S B 4% 00
5 11T DAL I 00 AT 1 0 SR W DS (38 2 P T R A . %5 1 T LA
FRSFIOAE . b, (AR

(B 7ok 5005 (Method Editor) + 4654 87 111 e 5177 Vbt i %7 1 FLBER
BB

22



STA 6000 1 1 F- it —PerkinElmer

|| BT (Data Analysis) o 1% 2 1E T 50 1 R 4T 4 B 2 45 S h 2k
Bk, MR PN A S 2 Windows ARl SR BT IEHE, BN H 2
“Data” H3%, M ATLALE “Preference” HlsE 31 50 HE (KB H 3o

[©] Pyris ##&i#% (Pyris Player) o i%fir 244 2 & M Y) 2] Pyris #as i, 4k
JagE T, AT BLE SCRETIES, KW T — R AT TR E P AN AE
IR IR T o8 B A H BN e . AR T vk gmi, BdiRE. HdEatr, £2
FTENGE LA, T RRHE i SR ) E S AR BN — B0, 3 A B A e i A P 3R 1
FHEZAMI. WA LU T B BRSO

Dl i (New> o ZERBF % LI P T IFRT OB SCPF. GBI 2L
THREAAHE AT L e ARl o AT IR ARIRGS %A B K VRS
MBS, A& .

@ﬂﬁiﬁﬁ (Open) . LhfElA “New” F1 “Data Analysis” .

%ibuéﬁz%}% (Add Data) o £ =4 i (I ECHE SCAE & a4 B2 4087 IR 2 S
o 1% AEBEAT Hd 1 LEAC I AR AT H

B s pptr (Save) o R YRR B BB SCHR TR AT o 1 0 AT LA 5
SR AT S bR IZ IR BRSO B RS BN IE R

S yren (Print) . TEIHETE O A2
@TTEIWJ@F@ (Print Preview) .

X migs (Delete) . MR BT 1O SE 0 P92, LIRS AL . VR NI S
T

(Bl $% 51 (Copy) . %A 24 Hiris 2 I 42 0 JELEE AR BRI, YA 2 L 02T i
BaE B — i # D13 Windows BY U

Bl 5ok (Method Used) o I SrRskBCS TSP GRIEF)
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STA 6000 1 1 F- it —PerkinElmer

VB i R (Grid) o TR I R A R A

Ebﬁbmm)o%ﬁﬁﬁﬁﬁﬁﬁ%%%ﬁﬁﬁﬁﬁﬁﬁﬁﬁ,EEEE%%
PRAFH BT o, BT SR B S

gﬁ%?iﬁﬁm (Radar Window) . ¢T38 % H A48 WLHT 3.

DE| e Yl (Swap YD o SARECHE A P A P A S 4 DA LB (R
ORI LA AN, TP AT DU I e LR B Y R 2 A Y
sk fa o LIRS IR AE, W s

x|

F:htest4. pdid

Select Y-axis to use for focused

1 (Left Inside)

[ ok | Cancel | Help

A LALE R 37 B ME P e 565 2 1) A B il 1) B4

[ e x ks (Rescale X) « ZEUIRAN BFAR A BCR TR A LK 8 4 B0 A5
T, ESEAEFIZIOAE, AR TR X AR AT A, LR
MR BRI M 7R ORI X ARKR IR R AR S B[]
A , HHEERR L

0 FE O SRR LB T RO AT AR S PR 1 2 A8 O BAZE ) S 5
B, ifi FLATCAE ARG ot Rescale it iy ScBLAR A5 e 35 % 11«
L e v Ak (Rescale Y) . FIUAE X Ak ShAE AL (B BEREAT SR B0 fr 1
.

L52] x A bl 57 (Full Scale X AXis) o ik BEUBAE X 7 1 20 I
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STA 6000 1 1 F- it —PerkinElmer

L]y me bz 5o CFull Scale Y Axis) .« iFEIBZE Y J s %l ot
o] w0 B (Full Scale) o iFPTEAE XA Y F7 i i 218 B o7

[ 355 1A ot CPrevious Scaling) .« %y A RS HEDI A 4: A6, T
IR L LA AR A1 2 AR B AR AT S LR RO T SR
) LRk, T LA .

lea | oy X ABEFION S (Log X) - 3 SR AN /R 1T LAt L«

Boa i v AREFEOH S (Log YD) o A SIS AT LU

l—B—C-[ thk I FF# (Shift Curve) o AILLKE DSC #wiimhde b R-1#, Mm7{iE s
HHEZ AR AL A 2 KIS, R AR th 2 AN RE L R, midia it
BLITR W

Iy, BURSRBARAE RS “ 7 . R Rl RO SRS AE 20 o b i Beg sl ir
BCAURBL i b i B (R N 22>, e DAFE BT R A AR

E%@WU%TD (Legend Window)

Sl i i 21 CSlope) o 12 0 S AR S B T —
VBRI & 5 2 R P A

BN OL T, FEWG 8D M2l 540 % D a8 At B “X7 , H P sk #E 8) AR
AR R R L X S, AE BT TEHES . “Align Endpoint” J&— MEH H M4,
TERE T mT LUK PR I £k ) 2 S I R AE A e 28, T 7 (B (P LR AR

B 5 i o1 (Logend Window) - 2y &4 th 53 5 11 e BT i 4 0 PR
KT S8 L 5 T I P T LI PR 1 o 4
AL, X AU T P 4 ST T T 00 2 4 IR SR Y, [ i
S BRI 7 1o 8 7 A S
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STA 6000 1 1 F- it —PerkinElmer

gﬁﬁﬁiﬁ(mmm)oﬁﬁéﬂuﬁﬁﬁﬁm$%E%&§ﬁE%ﬁM%i
TR IO T BN A R B RAT AL o e e 5 AT R A -

7t “Type text to be added” 1, FI vl LUIAA L 40 N FARFHISCAMF B W
RANAEZT 40 NFRF, WSR2 E . P rT DOk EE 2 A iz SN
ZIINE . £ “Select Rotation” 1, JIJ" AT LAESESCF I BonT7 10, HLanTE BIE 2
Ko gl “Font” 4245 H Windows FRifk 44 MRS XS UG AE,  FH P T LAy {5 1B ¢
TR SCF RN BUEAE . AR SIERE T FT ), I S I SOARAE B A SIS
P SCUEI 304y, T L E TR U I B e R AR R T B S
(0173 PR G NGV I 2 e X T 2 o 3 e S A YT AR A " e DR A7 AT RO E e
FTHREAE AL “OK” a2 R HIRIEAE,  [RI4s ML BoR SC IR 4%, P
W ) AR T E R WA S . WAEIE, AT RAYESCF b AR 80

L] ¢ i B4 (TempiTime XeAis) o SIZHL X A i1k 263 FESEL e 3
HORF TS, 4746 B P (R AR BRSSO L T 34T T RS0 MR ( Lt
SRR ) DU AR S I T 0 A B0 S22

4252 E

e File3xEg

STA 6000 [ SCAFSBIRT LLAy A DRI IRk it (2844 0 stam,  BRIADRAF
£ C:\Program Files\Pyris\Methods ) . % #is SCf (J5 444 O stad, BRI R A7 B 42
C:\Program Files\Pyris\Data) . #%1E3CHF (JE 444 A stac, BRIN{RAFEE4% C:\Program
Files\Pyris\Calibrations ) LA S 4% 51 SCF (J54i4 Jy stap, BRIMRAZ 42 C:\Program
Files\Pyris\Player Lists) o FJ /0] LAZEAH Y G LTI NSO, 490 an 7 5 15 2 4
AT IE SO, A A PR ES b TR SO, DL HE. F P AT Bk
BT —AN30fF, R BLERET TR 2 A S0k

o FEdit3EE
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STA 6000 1 1 F- it —PerkinElmer

AT 4 Tidn4, Delete i H T8 BB B 10 Hh I 224 i F) 1T 48 B S0 7
8o TV RIS i 2R AE 20 B AL TS SRS IO T e, B il 2 1 75920 HY B
brZetlAe ihgk b BEA A Hh B A al . Copy i & R 20 i
2R IR AR bR AN AL bR (K BT AT (S 02 Windows B [o aniRiZzihk Lk 45 Fbr
VE, W DL PR DMERAT TN Rl SO, 28 Copy fir4Jm 21 Office <54k
PErboRliG, 25 5 A% o

o View3gHE

Method Used... 7% H] TR 6 2% sl i 4 i) vk Jm 0k, B2z th 2ot FAn b g 12k
RN IXREAEEAT MRS, B SER S S FH P AR 208 MIN R SE 50 ik R
TEREAT I kgt N B A7 F P N 045 BRI SRR A 21, 300 THds i iR A H .
FEFH I XHEME R 455024 5 . Sample Info BT FE S BHE, AR EEE SO 4
NAFIBHEAE . SR ) BEELSCPE FE TR A5 (5 EL: Initial conditions 5T T 2 S 56
[W)UaAE K Calibration T THIZ5 H1 1% M B & AE AT RS T 3R43 %) Validation BT
R TTVE R B AR BN LS R ST T S SR il
P2

Results 74 FH TS {7 2 1 IO TH LSRR, 32 2O SENNE BR /R H] .

Legend it 3Lt BB B 11, 45t i ad 1 ep B A e i BB, DU (S o6 it
2RIy HE. PTLAE TS 11 b AR O AN IR i 2k

Radar i 2 H T B FIEE L, S 4G shth&km a3, AR T
RRIZHE” OB B HE R — N AT BT SR o i T, BUbRHE H— M5 35 0 i
LRI TEME, ARG EMEF X bR, BIelB iz e E R NS E B4 E 0 Bn)
WRZET TS Y R HE” AEIEAN ML h IO B o % 001 7 5 i 2 i 8 g2 0 53
Mo 1ZArAE T HS FA .

Grid iy 2 F T B E Bon R B AR K RIA% o 1% 27 T4 FAA 1 .

Rescale Tools H T~ i 7~ 5l B i Rescale T.H. 4%,

Toolbar F - 7~ BBk = T H 4%,
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STA 6000 1 1 F- it —PerkinElmer

Status Panel 1~ Ke ik B2 2 RS THIAR

Control Panel ] -1+ ! 77~ B e 4 1 T A S 1
e Display 328

Rescale X, Rescale Y iX P> 5 - SESEHIN I TEARBR I T HE,  EL AR AA A 1) 48k
WORIEAT AR BRI TBOR A, W 2 FH P 23 Hetts 1) 7 2

Weight %+ 2528 S TR i 2 AR b5 g T 1 40 L

Log X LAz Log Y JHI-J- S BILRE AL BR Al 70 0] B AR bR MG M AR b 2 ] D) 45 T R

Annotate i 54 FRiE T H,  JTTAE BB a3 Il XURS (377, R s 6 &5 SRk
ITHIE, FEETERAR.
e Curves k&

R R BSOS A 2R A S B0 A (i) T RoR,  DURf e s at 5o &
U R — AT HR A

Heat Flow > Heat Flow (#i) i FH T Bon B th 2 i #i s 5 iR i v
JiEgmER TR R T IR A A, WNZA SR TR S GRS )

-

Heat Flow > Baseline Heat Flow (JE£#ii) %4 H T 27m FH - B0 i e i S 2
PS5 o WER PRAE T gn i FR € FBR IR 2 S0, I o — 4 FA0 A 1R K
P4

Heat Flow > Unsubtracted Heat Flow CRANFEL A %A H T Wom R gAT H2k
R AT T o WA TSEHR s B AR S, M4 Heat Flow iy 4 1)
REAHTA] .

Weight > Weight (Ff b EE 5D %4 H T 0 74 b TR 5 B it P52 R I [ 1) 22 44 1t
2, W TSEAE TV S R A e TR IEEZ SO, R R A 4 R S ) R
Zf5'T.

Weight > Baseline Weight (A4 ®Hi) H T Bonikg K mE 4.
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STA 6000 1 1 F- it —PerkinElmer

Weight > Unsubtracted Weight CARHIBRFELEH 1) T8 7 S (14 i 2K o il 28,
AR BRI 1) 2 1 2%

Temperature > Sample Temperature C(Ff i) Ay 4 M T W FE P S F R T
WEES 2. W, PRSI S TREPIRE .. RS2 D SRR B,
HAL R Bl T B2 55 AT Ok

Temperature > Program Temperature (R /il ) 4 T W s B i B2 th 26

Delta T H- T /-t i 5 S W MR 205 5 2k, %55 bk Delta T

(BN R °C) , REARKR A R BRI )

Heat flow Calibration (F\JRiAE ) WoRBEISMHGRGE Tk, H ) nr Lok 55z

I AT LR

Enthalpy CRIED i H1 - 2= W0 il 2 i 0 (i 200d o« =4 38000 ith 42 bl ARl 2
I, Zm 2 Kexs EE R e AT Ry, SRHIAN [R) UL B2 DX TR] RSB R /N o AEEAT B
Hrinf iz S AR A

Step Select CGLIEIEFE) AR R 1ZI0, W £EEFE Heat Flow , Unsubtracted
Heat Flow &% fiir 2 I A LUIE i 55 H A0 TR A £ AN RN AR > T AR I e o 4 SRAS
g, WA R RN TEAE, EIANREREAT D IR %

Endotherms Up (W#ivin) b)) & an e rp, M e S th 2 g 1a) oA Rk,
R AT FHAR AR DSC e W FA ) R, 1 B M B e e A ),
1t Pyris software 5.0 LA (I ARASH 48 B Qb ™ #s AE , 58 AR F P 1) 547

Start Time At Zero (JFURRTIRIE A 0) Zan S AEBAT Z 004 A H, Wi
DU ) B AABR, AT LA (i BE AT i b . i 3k AriZait, IR — AN Szt 20 1R )
IS M 0 TR . #iln, FERE T — RIS 2 fG5 TS 85 s rawrse, )
AJ DAR 5 {8 b b ) B S5l 45 i IR T AR i 1l 52 4 0,
e Math3gE

e B A 5, bR I S, nieia 5T SR EIE A

29



STA 6000 1 1 F- it —PerkinElmer

Derivative (K3 fir % FH TR ARG SN HIZ i — B S8 k& AL |
Az, Zar R TP N VERA . KT )E, TEkT THesssE, 450
ek ml e — AL .

Subtract CHI9) fir2- SEHIL M 45 AH [R) S 2L 1) ith 2 1) yalos 54

Add CRRIND  fir 2 SEBILM 2% 2R RUAR [R] 1) it 22 (1 In iz 5

Average CPIIMED i 13RI 4cZ2 S AH [ S A iih £ i~ 241

Smooth V5D iy 4 F T SEIUAFAE M 26 g Thee . %2 E 2 AT T
A B ) IR A N B AT I Ab 3 . FER T DSC AR A I R A TE
i, RO ATRER B as R AR, AR AT A R
o Calc3E&

R SRR T I AR 2 e A, U IR M 4R T %8 K D RE R R
Wz, A BEAN I H 34T B 2 A5 R

Peak Area (IETETFR)

22 T B0m th & g AR AT UF B, R R 2 a2 —. 1k

PRz a, Sl LUR S

Il Peak Calculation
Calculation Limits Include Area Options
Left Limit: Baselios: 2| e Area curve
5524 °C [ DOnset [~ Display Limits [~ Partial Areas
Right Limit: [~ End I Tolerance Test | | [~ kJ per mole

2436 °C [~ PeakHeight = [ | [ a/mal
| Calculatel Cancel | Help I

I, FEm e 2wy o LAY “X7, P SREEAEMAS “X7 S22 5
FHBAT H UG T . P o LLUEE e AN “X” SoRIE R A S R R,
WA LLYE “Peak Calculation” XJ i AE LA A A A A Ft o 30 HU# 7 {8, e 5
RECRUEEHE 1) — SCPERDRG B o — UL DR B I AR AE A i il A RIDAT, ANEEEAS
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STA 6000 1 1 F- it —PerkinElmer

KRKRFNAAN o AEHEATUE AT, FELR R IO 45 AR K52 . FoBThR I Pyris
software $2 41t T 4R 5 Rk £ 7 %

bRifEFEZE (Standard) « CREPIAN G s LA ERATIE, PR MR . 7RSI i £k
B H H G B S B BIIRAE T o A0 7 SR 4N T 5

“S” JEALZL (Sigmoidal) : PIANI AU IEIAN TR LA ELZAHIE, T2 H"S" TR ZeAtiE .
& TR S IS B S TE o et {5 A7 EE AR T AR A, U0 i AR A
W J5 PR ANAE R — HZe b, TR AHER, B PR HERE L 27 AR ORI 22
an B 7 AE “ Peak Calculation ” X 35 HE B 1 2 “S” JE AL, W Al
“Calculate” #ZHl fids 23 H ) A2 B 45U A I sl AR B e, BT A
D U AR U i i AR A B PR AN, PSSk A B el 1 S PR 5P 47
ST R AT 7 %

AT A L IKEREZE (Horizontal from Right) = MG i f A 40Kk, 3104 i
SR, U SRRNREARAS, IR AR ARE . RN T SR R 3 S A
P14 AN TR Py i 0332 H PR 85 SRAH ZE1RK

MR ARV (Horizontal from Left) = 2R (3) , JUR 5 =42 /K
2

F L (Horizontal at Zero) = JHHARKR A FHIAK T2l sk, KPP
g f TR TR 20 4 . T IR ZE ALK

B T R4, FH AT LLAE “Peak Calculation ™ 176 HE HL i 48 40 #7 45 R

PR TSR (Onse)  Si{E (End)  WEm{EHSE, IEREXT LA, AL
AN ZEATHOE, LSS A0 W (K T RURT s e A2 17 Bl ith 2o G805 4 AERT ST
AN RAT R AR R AT

Peak search (I£1%%)

iy A F AR 2 HR i R Ve N R U IR A R B Peak

Search” XJiEHE, 40 FFrw:
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STA 6000 1 1 F- it —PerkinElmer

Peak Search @

Settings Labels Include
MNoise Threshold: V Peak X
Im i 5 [™ Tolerance Test
Area Threshold: | fheaky
_1 465 o) [ Peak &rea ——]
Minimum Peak Height I el mole
|1 1.72 v I a/mol
| oK | Cancel I Help |

PP AT RULAEAZON 5 AE TH R E A5 5 A B (U 5 v A 22 /0 B T A 2
2/ o T TREHEDIRE, Pl izdiar &AL w A, B RZHN IR
B IS 5 4 T VA

Onset (288

2 T 2 AR R AR 1, BRI 5 TR W] 8 O B B 2 (0 . i 2 22

/DA BN 2 Onset s i 7 AE 5 HS B TR AE HH RIE
Tg GEBWETIRE)

T BB A AR RE 1) 704 . DSC A2 W FT A o B A e AR 1 R ) iy ) T R
W) R A PRI AR I, AR AR R s AT HL AR AR A, T DSC X BRI AL AR I
TS PR A R R P LA AL S B, DRI, SR e W B, AR T
Uik PRI A AR DSC #viit ith Sl b A th e by b i) & BHIRAR AL AT R st 2 3
BAMEE AR IR o TR AN Rt A8 T LI B B A B AR, B TR R BME 2 S W
2, AEREEWELS, K, AT BT R & T,

MEFEML I A 2 AT 2 e L ATH Gk . BT EVFZ 6, Bt
HME ALK, B T DU AR R D e 7> ik . k4% Tg ),
23t “Glass Transition” XJ1AE, FH /Al LGSz Aot s &5 R P AL S I N
B VLSRR — i A B AR R A% o S s AT R T TR N7k, el BUH
BRUbR SN B I o U B )2 SR HEAN S By, o N A T AR I (17 B
ek .
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M1 T B A AR — NIRRT N R ARG, DR AT S 6 45 RN 45 H ik
AT A BB AR L o A0 B DU R £ ik

b FAS Ak T S AMETR JE (Half Cp Extrapolated) S #5586 A8 1 5 1 E i S kAT
LeVEAMERN AR I, A LE AR AR IR

P3 KU E (nflection Point) F5 % AR 3 % v [ 3 55 Z0 1 s PR . AL

REd g (Half-Width) 45 Onset ifit 571 End YL H s (1305 . Onset i & 2 4
AR i He 2 15 AR AR o it e b T U AR R e K AR D) e RO AT O Y FR B2, End
T S HE AR S B e 55 2T IR R AR B /DS )AL IR DT IR AT s L FR)

ARG B2 (Fictive Temperature) JE AR ¥4 2 SCH . 1T BB AL e AR iy o A7 EE A
ARAY, PRI BRI Ze AT R 0 R AT S e 2 7 A B A Ab B 25, R
RAARAY, AR5 I M e T e A s BRI o 2 D RE 2 2T T B AR I A ot
R 04T s, A0 R A & Praa i B2, 2R L L AR BE IS
2~3°C.,

Step (EMEET)

MTamrabReER, HTHRERMERZMEH &mES. /£ TGA

TMA/DMA 1 8%, DSC HAVE

Delta X_(XZ18)_
SO I L 2 K T B

Delta X (Y 18
B I L 2 ) T B

Even Mark (B4R
BEHCR— S0 X ATY A4 KR

Trigger (fifi& &)
ZAT A IIBEA Onset Air A AHAL, FHT-XF Onset S AN Bl &5 (1) 5 AR ke 4A U B AT

BEHL
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Slope (HlZ)
TRl . & Zam4 a5t “Slope Calculation” X iFHE, i/
AT LI 2 o S R P 3 0 BEA T R I T

Kinetics (F1 A%
S E W E SRR, LR T AR SN 2% (Isothermal Kinetics) « 148 )
“¢# (Scanning Kinetics ) FI#FEZ)) Jj%* (TGA Kinetics) 4347

DSC #ih S 2 5 AT, R BT G M R AT 34T 3 2220 b, r sk
SN SN FRATIN T W ARRESE S 1A S AL, SR AR thg . RGE
M2, En] LIRS BRI, DUR SRR AL PCIRZS T 1 S MR AL AT 7
PR VA%

DSC Sl 8l ) 24 ST 2 3 4k UL Sl L A i th 26, A4 Arrhenius X &,
EARITN 7. RN RE. EReSEsh 12254 I I E, nl LA
[ S ER

KFBNII2ERAA T, v S WARAEHEAE 8 122 P it
e Tools3EE

R P R S S OGE M B % 1 (f7 T Tools > Preferences) o« 1E
2 PR PAT EMCES I BRA S, L d bR, PR R A4,

Load Temperature (ZFFIRLEE) : FH AT DAFE G 1 e 24 BRI I 20PF UL
M s Go To Load L5, AXAs 2 H skl B 4 1l 2 AL

Go To Temp Rate ( HAL#EHRIEZR) « M H i Go To Load #%4l5# Go To
Temp %45, XSS & 440w P IRECR B F5 2 R, %R 1% & % 1 3
T8 H P T BALE 100 °C min-t Y [l P e BOA SR . A& 1 B 30
FAEE RO = SR

Ordinate Filter (H\ARFRyESE) « H TSemFigfdnithd (E&E) , M4 ik
ZIH G, AL E B I ) R0 S AE B 5 A AR 125 BB IR )G
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Cooling Device (AIBEE) - Al % LK) N PrHEF LS STA 6000 fr 1V
WA, AUHEIIORE VA Ve A 5 S IE R+ .
e Window

FHgAE, AR A RS R w L 2ok )7 0. BRIA) 2 Cascade
(28> Boniae Wl LOEEACHHESI R BHS . 0 AL 1 (LG anis iF &
1), BRI R AR R, RO E O, Ssek s 0 sl Cascade
Ja A RER M. AE Windows S, IEA METFTITHIE FIAIER, A Hn] DLSOE 5 220
Bl A

e Help

TR S

35



